
Agilent Technologies

A g i l e n t  E 5 8 1 3 A  N e t w o r k e d  5 - p o r t  U S B  H u b
A g i l e n t  N e t w o r k e d  5 - p o r t  U S B  H u b Agilent Networked 5-port 
USB Hub

E5813A I n s t a l l a t i o n Guide



Agilent Networked 5-port USB Hub

 



Agilent Networked 5-Port USB Hub

Notices
© Agilent Technologies, Inc. 2004

No part of this manual may be reproduced in 
any form or by any means (including elec-
tronic storage and retrieval or translation 
into a foreign language) without prior agree-
ment and written consent from Agilent 
Technologies, Inc. as governed by United 
States and international copyright laws.

Manual Part Number
E5813-90001

Edition
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Printed in USA

Agilent Technologies, Inc.
815 14th Street SW 
Loveland, CO 80537

Warranty
The material contained in this docu-
ment is provided “as is,” and is sub-
ject to being changed, without notice, 
in future editions. Further, to the max-
imum extent permitted by applicable 
law, Agilent disclaims all warranties, 
either express or implied, with regard 
to this manual and any information 
contained herein, including but not 
limited to the implied warranties of 
merchantability and fitness for a par-
ticular purpose. Agilent shall not be 
liable for errors or for incidental or 
consequential damages in connec-
tion with the furnishing, use, or per-
formance of this document or of any 
information contained herein. Should 
Agilent and the user have a separate 
written agreement with warranty 
terms covering the material in this 
document that conflict with these 
terms, the warranty terms in the sep-
arate agreement shall control.

Technology Licenses 
The hardware and/or software described in 
this document are furnished under a license 
and may be used or copied only in accor-
dance with the terms of such license.

Restricted Rights Legend
If software is for use in the performance of a 
U.S. Government prime contract or subcon-
tract, Software is delivered and licensed as 
“Commercial computer software” as 
defined in DFAR 252.227-7014 (June 1995), 
or as a “commercial item” as defined in FAR 
2.101(a) or as “Restricted computer soft-
ware” as defined in FAR 52.227-19 (June 
1987) or any equivalent agency regulation or 
contract clause. Use, duplication or disclo-
sure of Software is subject to Agilent Tech-
nologies’ standard commercial license 
terms, and non-DOD Departments and 
Agencies of the U.S. Government will 
receive no greater than Restricted Rights as 

defined in FAR 52.227-19(c)(1-2) (June 
1987). U.S. Government users will receive 
no greater than Limited Rights as defined in 
FAR 52.227-14 (June 1987) or DFAR 
252.227-7015 (b)(2) (November 1995), as 
applicable in any technical data.

Safety Notices

CAUTION

A CAUTION notice denotes a haz-
ard. It calls attention to an operat-
ing procedure, practice, or the like 
that, if not correctly performed or 
adhered to, could result in damage 
to the product or loss of important 
data. Do not proceed beyond a 
CAUTION notice until the indicated 
conditions are fully understood and 
met. 

WARNING

A WARNING notice denotes a 
hazard. It calls attention to an 
operating procedure, practice, or 
the like that, if not correctly per-
formed or adhered to, could result 
in personal injury or death. Do not 
proceed beyond a WARNING 
notice until the indicated condi-
tions are fully understood and 
met.

Windows is a US registered trademark of 
Microsoft Corporation.
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Introduction

The Agilent Networked 5- Port USB Hub for Windows uses 
USB over an IP connection, this goes beyond the traditional 
five meter distance limitation between the USB device and 
the host. Now USB instruments and devices may be located 
anywhere on a wired or wireless LAN – without a locally 
attached host PC. Since the host PC or server may be 
located remotely, Agilent’s LAN/USB product enables devices 
to be deployed in harsh or non- secure environments. This 
Ethernet- attached solution provides five USB ports to 
connect peripheral devices such as instruments, GPIB 
converters (such as the Agilent 82357A), or general purpose 
peripherals.

Cabling E5813A Networked 5-Port USB Hub

To connect the E5813A Networked 5- Port USB Hub to a 
network:

1 Connect a standard Ethernet network cable to your 
E5813A Networked 5- Port USB Hub. Then connect the 
other end of the Ethernet cable to a 10/100 BaseT switch 
or hub.

2 Connect one end of the power supply* into the back of 
the device and the other end into an AC outlet.

NOTE Power to this product may be supplied by a UL Listed Direct Plug-In Power 
Unit marked “Class 2” or a UL listed power supply rated with a minimum 
rating of 5 V dc 2.5 A if used in the U.S. and Canada, or a power supply with 
similar rating and approved by your local safety code if it is used 
elsewhere.
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Installing the Drivers

For Windows XP and 2000 Users

You must install the drivers using an account that has 
administrative privileges.

1 Insert the “Agilent Driver” CD into your CD drive. 

2 If the CD does not automatically start, then open the CD 
folder and double click on the setup.exe program.

3 Select the “Install Drivers” button to start the install 
process. There are multiple resources on the E5813A 
which have to be setup, so follow all of the on- screen 
instructions to complete the installation of the E5813A 
Networked 5- Port USB Hub. 

After installing the drivers, the E5813A Configuration Utility 
automatically starts so that you can configure the device. 

Configuring E5813A Networked 5-Port USB Hub

For initial configuration, the device must be connected to 
the same local area network as the configuration PC. Note 
also that the E5813A Networked 5- Port USB Hub cannot 
function behind a firewall.

NOTE Note: Drivers may not have received “Designed for Windows 2000” 
certification. If so, Windows displays a warning: Digital Signature Not 
Found. While the drivers may not be Windows certified, they have been 
thoroughly tested. Select “Yes” to continue with driver installation.
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In order to configure the device:

1 Launch the E5813A Configuration Utility from the Start 
menu. The utility displays a list of discovered E5813A 
Networked 5- Port USB Hubs on your local subnet. A new 
device has a default IP address of 0.0.0.0. You must 
configure the device before it can be used on a network.

2 After the E5813A Configuration Utility has been launched, 
it will reside in your system tray. To open the utility, 
double click on the Agilent Networks icon in the system 
tray. If you try to start the Utility from the start menu 
and it does not launch, double- click the icon in the 
system tray.
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3 You can identify each E5813A Networked 5- Port USB Hub 
by its IP Address.  If the device is not configured, then 
the serial number can be used for identification.

Unconfigured devices are listed separately. For example, 
the device noted on the previous graphic with serial 
number V320F0218 has not yet been configured.  

4 To discover E5813A Networked 5- Port USB Hubs on other 
networks, see “Using the Configuration Utility 
Program” on page 14.

5 Double click on the E5813A Networked 5- Port USB Hub 
or select the device and press the Configure button to set 
the IP address, Subnet Mask, and Gateway.
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6 Enter a Device Name that easily identifies the E5813A 
Networked 5- Port USB Hub .

7 Enter the IP address and Subnet Mask. Contact your 
Network Administrator for IP address assignment.
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8 Enter the Gateway for your network. In a network using 
subnets, the Gateway is the router that forwards traffic to 
a destination outside of the subnet of the E5813A 
Networked 5- Port USB Hub.

9 To add this 5813A to your connection list, be sure to 
check the box that is circled in red in the previous 
graphic.

10 For the changes to take effect, you must choose the 
Update button to reset the device.
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Configuring Your Host PC

To configure a Host PC to access the E5813A Networked 
5- Port USB Hub:

1 Launch the E5813A Configuration Utility from the Start 
menu. The utility displays a list of all E5813A Networked 
5- Port USB Hubs on your local subnet and on any subnet 
configured in the Discovery List. 

2 After the E5813A Configuration Utility has been launched 
it will reside in your system tray. To open the utility, 
double click on the Agilent icon in the system tray. If you 
try to start the Utility from the start menu and it does 
not launch, double- click the icon in the system tray.

3 The Configuration Utility automatically discovers E5813A 
Networked 5- Port USB Hubs on your local subnet. To 
discover devices on other networks, you must add their 
network address to the Discovery list. Select “Discovery 
List” from the “Edit” menu. Add the Subnet addresses to 
the Discovery List Manager. For example, to add the Class 
C network 10.21.1, you must enter 10.21.1.255. Note that 
your routers must be configured to pass subnet 
broadcasts.
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4 When you have completed adding the subnet address to 
the Discovery List, click on the Close button to save the 
list. The screen will refresh within a few seconds.
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5 Select a E5813A Networked 5- Port USB Hub and press 
the Connect button to add the device’s IP address to the 
Connection List. The host computer then attempts to 
connect to the device. For a list of the E5813A Networked 
5- Port USB Hubs where you are currently configured to 
connect, select “Connection List” from the “Edit” menu.

6 The Found New Hardware Wizard prompts you to search 
for the drivers: one time for the Remote Hub and two 
times each for the USB Host Controllers and the USB 

NOTE If you were able to configue the E5813A, but then were not able to connect 
to it, the problem may be that you need a LAN “crossover” cable instead of 
the regular LAN cable.
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Root Hubs. Select the “Install software automatically 
(Recommended)” option and click the Next button. If you 
get the warning message indicating that the drivers have 
not yet passed Windows Logo Testing, choose the 
Continue Anyway button.

The E5813A ships with the Driver and the 
Automation- Ready CDs. The Driver CD software must be 
installed for the product to operate. Once the Driver 
software is installed, the E5813A should be attached to a 
LAN, your PC should be able to connect to it, and the five 
USB ports on the E5813A appear as additional Windows® 
USB ports. These ports can be used by your PC to connect 
USB instruments, general purpose devices, or converters 
such as the E5805A USB to four port RS- 232 converter or 
the 82357A USB to GPIB converter. The Automation- Ready 
CD with the Agilent IO Libraries Suite allows you to use I/O 
libraries (for example VISA, VISA COM, and SICL) to do 
“instrument style” programming of instruments, devices, or 
converters. It also provides a suite of tools for connection 
management and interactive instrument control. If you are 
using VISA or other T&M specialized software to program 
instruments, or if you are using application software that 
does instrument control, you may want to also install the IO 
Libraries Suite.

NOTE So the correct 82357A drivers are accessed, the 82357A requires the 
E5813A to have version 14.0 or higher of the IO Libraries Suite installed.
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Uninstalling the Drivers

To uninstall the E5813A Networked 5- Port USB Hub drivers 

1 Launch the E5813A Configuration Utility from the Start 
menu.

2 Select Preferences from the File menu and click on the 
Uninstall button. You must reboot your PC in order to 
complete the driver removal.
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Interpreting the Status Lights

The E5813A Networked 5- Port USB Hub has 6 LEDs on the 
front panel, the System Status LED and 5 hub LEDs. Each 
LED is capable of displaying 3 colors, red, green, or orange.

System Status Lights

On initial power up the system status LED is orange for 2 
seconds while the system initializes; it then blinks green.

Hub Lights

Green hunting pattern across all LEDs Not connected to a host.

Orange alternating on ports 1-3-5 and 2-4 Updating image in Flash. Do not remove power from the 
E5813A while flash is being updated. Doing so will damage the 
E5813A.

Solid Green Hub port is powered.

Green over Red hunting pattern Please call the local Agilent support center. Locate a phone 
number by checking http://www.agilent.com/find/assist.
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Using the Configuration Utility Program

The E5813A Configuration Utility displays E5813A 
Networked 5- Port USB Hubs grouped by their subnet. The 
Utility automatically discovers devices on your local subnet. 
To discover devices on other networks, you must add their 
network address to the Discovery list. Select “Discovery List” 
from the “Edit” menu. Add Subnet addresses to the 
Discovery List Manager. For example, to add the Class C 
network 10.21.1, you must enter 10.21.1.255. Note that your 
routers must be configured to pass subnet broadcasts.
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Preferences Menu Options

File Menu: Preferences Allows you to disable or modify the 
frequency in which the utility updates its discovered E5813A 
list. Enables the logging of driver events to the system event 
log and allows you to uninstall the drivers 

Edit Menu: Connection List Contains the IP addresses of the 
E5813A Networked 5- Port USB Hubs where this Host PC 
tries to connect. When an IP address is added to this list, 
the Host PC immediately tries to connect to the device. If an 
IP address in this list is deleted, all USB devices attached to 
this E5813A are removed from this Host PC.

Edit Menu: Discovery List Contains a list of subnet addresses 
of remote networks where the configuration utility searches 
for E5813A Networked 5- Port USB Hubs.

Command Menu: Configure Allows you to setup the TCP/IP 
parameters in the device. You can also add this IP address 
to the E5813A Networked 5- Port USB Hub Connection List 
by checking the Connect to this Concentrator (referring to 
the E5813A) check box. 

Command Menu: Connect Adds the IP address of the E5813A 
Networked 5- Port USB Hub to the Connection List.

Command Menu: Event Log Retrieves event information from 
E5813A Networked 5- Port USB Hub. Use this to gather 
information for Technical Support.

Command Menu: Reboot Causes the E5813A to reboot.

View Menu: Driver Information Displays the version numbers 
of the E5813A Networked 5- Port USB Hub drivers and 
allows you to uninstall the drivers.

View Menu: Refresh (F5) Updates the Discovered E5813A 
Networked 5- Port USB Hub List.
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Understanding E5813A and USB Hubs

Hubs, critical components in the plug- and- play architecture, 
are wiring concentrators that enable the attachment of 
multiple devices, thus converting a single attachment point 
into multiple attachment points.

The E5813A is a LAN to USB converter. As such, LAN traffic 
can and will introduce some level of non- deterministic 
delays. For example, if you are using USB to RS- 232 devices 
connected to the E5813A, you should turn on hardware flow 
control (RTS/CTS or DTR/DSR) for data transfers.

Also, the USB architecture allows a cascaded multiple hub 
configuration with certain power limitations (explained later 
in this section). See figure 1.

Figure 1

Each hub has an upstream port, connecting to the host, and 
multiple downstream ports, connecting to downstream 
devices, including other hubs. A hub can detect attachment 
and detachment of downstream devices and enable and 
monitor the distribution of the power to downstream devices 
via their integral hardware and the operating system. 

Each USB device reports its power requirements to the 
operating system, which then enables and disables the device 
as a function of its power requirements, and the amount of 
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available power. High- speed devices typically need to be 
connected to a self- powered hub, which obtains power from 
its external power supply and provides up to 500 mA for 
each downstream port. Only simple devices, such as a 
mouse, can be connected to a bus- powered hub, which 
obtains power from its upstream host and provides up to 
100 mA for each downstream port.

Due to the limited available power for bus- powered hubs, 
cascading two bus- powered hubs is an illegal topology, and 
devices connected to the second hub will not function. (USB 
specifications limit the connection of a bus- powered hub to 
a self- powered hub or host only.) 

According to the USB Specification, the maximum limit of 
hubs cascaded in series cannot exceed five. In other words, 
you may have a maximum of five hubs between any device 
and the host. This does NOT mean that the maximum 
number of hubs in a system is five. Indeed, up to seven 
hubs can be connected parallel at any given level. You must 
tally both external and embedded hubs when counting 
downstream hubs.

NOTE The E5813A contains a self-powered USB hub and can be used to power 
simple or high speed USB devices.
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Support

All support can be reached by contacting an Agilent call 
center. For your nearest call center, go to 
http://www.agilent.com/find/assist
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E5813A Specifications

This appendix lists E5813A Agilent Networked 5-Port USB Hub Technical 
Specifications and Supplementary Information.
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E5813A Specifications
Technical Specifications

Technical Specifications
General Requirements

Minimum System 
Requirements

Windows 2000 and XP; USB port

Supported Standards USB 1.1, 2.0 compatible. USB 2.0 devices operate at 12Mbps

General Characteristics

Power Ships with 120/230vAC 60/50 Hz at 5vDC @ 3 Amps max
Maximum Power 15W

Connectors RJ45 Ethernet to five USB ports

Configuration Remote configuration utility

Upgrades Field-upgradeable software and firmware

IP Addressing IP addresses from DHCP servers and static IP addressing are both 
supported

Network Support 10/100 BaseT support

Device Status LEDs for system and device status

Data Rates Data rates up to 12 Mbps per USB port

IP Addresses One IP address per unit

Downstream 500 mA downstream power per device

Server Support Single and multiple processor servers supported

Units/Server Up to eight units supported per server

OHCI Two Open Host Controller Interface (OHCI) controllers

Event Log Windows system event log for easy troubleshooting

Network and Device Recommendations

Network Utilization Network utilization below 50%

Compatibility Compatible with bulk or interrupt type USB devices; isochronous 
devices are not supported.

Dimensions

Length, Width, and Height 11.05 cm (L) x 18.29 cm (W) x 2.61 cm (H)

Weight 283.49 grams

Environmental Specifications
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E5813A Specifications
Technical Specifications

Operating Environment 0oC to 60oC

Humidity 0% to 95% (Non-condensing)
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1 LAN-5ポートUSBハブ

はじめに

Agilent LAN- 5ポートUSBハブは、USBに IP 接続を使用することで、

USB デバイスからホストまでの距離が最大 5 メートルという従来の制限

を超えて使用できます。USB 機器やデバイスをホスト PC にローカルで

接続しなくても、有線または無線 LAN 上のどこにでも配置できます。

Agilent の LAN/USB 製品を使用すると、ホスト PC またはサーバを

離れた場所に設置できるため、デバイスを過酷な環境や安全でない環境に配

置できます。この Ethernet 接続ソリューションでは、測定器、GPIB コ
ンバータ (Agilent 82357A など )、一般的な周辺機器などを接続するた

めの USB ポートが 5 つ用意されています。

E5813A LAN-5ポートUSBハブのケーブル接続

E5813A LAN- 5ポートUSBハブをネットワークに接続するには、以下の

手順を実行します。

1 標準的な Ethernet ネットワーク ケーブルを E5813A LAN- 5ポー

トUSBハブに接続します。次に、Ethernet ケーブルのもう一方を 10/
100 BaseT スイッチまたはハブに接続します。

2 電源アダプタ* のプラグをデバイスの背面に接続し、もう一方をコンセ

ントに差し込みます。

注
本製品の電源は、米国およびカナダで使用する場合は「Class 2」のマークが

付いた UL リスト記載のダイレクト プラグイン電源装置または最小出力が

5 V dc 2.5 A と評価されている UL リスト記載の電源装置、その他の国で使

用する場合は、各国の安全基準に準拠し、同程度の評価を持つ電源装置に

よって供給されます。極性については、以下を参照してください。
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ドライバのインストール

Windows XP/2000 の場合

管理者権限を持つアカウントでドライバをインストールする必要があります。

1 Agilent ドライバ CD を CD ドライブに挿入します。

2 CD が自動的に起動しない場合は、CD のフォルダを開いて、setup.exe
プログラムをダブルクリックします。

3 [Install Drivers (ドライバのインストール)] ボタンを選択して、イン

ストール処理を開始します。E5813A の複数のリソースをセットアップ

する必要があるので、画面に表示されるすべての指示に従って、E5813A
LAN-5ポートUSBハブのインストールを完了してください。

ドライバをインストールすると、E5813A 設定ユーティリティが自動的に

起動し、デバイスを設定できるようになります。

E5813A LAN-5ポートUSBハブの設定

最初の設定では、デバイスはPC と同じローカル エリア ネットワークに接

続する必要があります。また、E5813A LAN- 5ポートUSBハブはファイ

アウォールの外では機能しないので注意が必要です。

デバイスを設定するには、以下の手順を実行します。

1 [スタート ] メニューから E5813A 設定ユーティリティを起動します。

ユーティリティを起動すると、ローカル サブネットから検出された

E5813A LAN- 5ポートUSBハブのリストが表示されます。新しいデ

バイスには、デフォルトの IP アドレスとして 0.0.0.0 が割り当てられ

ています。デバイスは、ネットワークで使用する前に設定する必要があ
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ります。

2 E5813A 設定ユーティリティを起動すると、ユーティリティはシステム

トレイに常駐するようになります。ユーティリティを開くには、システム

トレイ内の Agilent ネットワークのアイコンをダブルクリックしま

す。[スタート ] メニューからユーティリティを起動できない場合は、シ

ステム トレイ内のアイコンをダブルクリックしてください。

3 各 E5813A LAN- 5ポートUSBハブは IP アドレスで識別することが

できます。デバイスが設定されていない場合は、シリアル番号を ID と
して使用できます。
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未設定のデバイスは別に表示されます。たとえば上の画面例では、シリ

アル番号 V320F0218 のデバイスはまだ設定されていません。

4 別のネットワークにある E5813A LAN- 5ポートUSBハブを検出する

方法については、38 ページの「設定ユーティリティ・プログラムの使

用」を参照してください。

5 E5813A LAN- 5ポートUSBハブをダブルクリックするか、デバイスを

選択して [Configure (設定 )] ボタンをクリックし、IP アドレス、

サブネット マスク、ゲートウェイを設定します。
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6 E5813A LAN- 5ポートUSBハブを簡単に識別できるようなデバイス

名を入力します。

7 IP アドレスとサブネット マスクを入力します。IP アドレスの割り当

てについては、ネットワーク管理者に確認してください。
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8 ネットワークのゲートウェイを入力します。サブネットを使用している

ネットワークの場合、ゲートウェイは E5813A LAN- 5ポートUSBハ

ブのサブネットの外部にある宛先にトラフィックを転送するルータで

す。

9 この E5813A を接続リストに追加するには、前ページの画面例で赤丸

の付いたチェック ボックスを必ずオンにしてください。

10 変更を有効にするには、[Update (更新)] ボタンを選択してデバイスを

リセットしてください。



32 E5813A LAN-5ポートUSBハブ

1 LAN-5ポートUSBハブ

ホスト PC の設定

E5813A LAN- 5ポートUSBハブにアクセスできるようにホスト PC を
設定するには、以下の手順を実行します。

1 [スタート ] メニューから E5813A 設定ユーティリティを起動します。

ユーティリティを起動すると、ローカル サブネット上と、検出リストに

含まれているサブネット上の E5813A LAN- 5ポートUSBハブがすべ

て表示されます。

2 E5813A 設定ユーティリティを起動すると、ユーティリティはシステム

トレイに常駐するようになります。ユーティリティを開くには、システ

ム トレイ内の Agilent のアイコンをダブルクリックします。[スタート

] メニューからユーティリティを起動できない場合は、システム トレイ

内のアイコンをダブルクリックしてください。

3 設定ユーティリティによって、ローカル サブネット上の E5813A
LAN- 5ポートUSBハブが自動的に検出されます。別のネットワーク

上のデバイスを検出するには、そのネットワーク アドレスを検出リス

トに追加します。[Edit (編集 )] メニューから [Discovery List (
検出リスト)] を選択します。サブネットのアドレスを検出リスト マネー

ジャに追加します。たとえば、クラス C のネットワーク 10.21.1 を追

加するには、「10.21.1.255」と入力します。サブネット ブロードキャ

ストを通過させるようにルータを設定する必要があることに注意してく

ださい。
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4 サブネット アドレスを検出リストに追加したら、[Close (閉じる )] ボ
タンをクリックしてリストを保存します。画面の内容は数秒で更新され

ます。
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5 E5813A LAN- 5ポートUSBハブを選択し、[Connect (接続)] ボタ

ンをクリックして、デバイスの IP アドレスを接続リストに追加します。

ホスト コンピュータがデバイスへの接続を試行します。現在接続が設定

されている E5813A LAN- 5ポートUSBハブのリストを表示するに

は、[Edit (編集 )] メニューから [Connection List (接続リスト )]
を選択します。

注
E5813A を設定したが接続できない場合は、通常の LAN ケーブルの代わり

に LAN「パッチ」ケーブルが必要である可能性があります。
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6 新しいハードウェアの検出ウィザードでは、ドライバの検索を要求する

メッセージが表示されます。リモート ハブについて 1 回、USB ホス

ト コントローラと USB ルート ハブそれぞれについて 2 回メッセー

ジが表示されます。[ソフトウェアを自動的にインストールする (推奨 )]
オプションを選択して、[次へ ] ボタンをクリックします。ドライバが

Windows ロゴ テストに合格していないことを示す警告メッセージが

表示されたら、[続行 ] ボタンをクリックします。

7 E5813A には、ドライバ CD と オートメーションレディ CD が付属

しています。本製品を使用するには、ドライバ CD のソフトウェアをイ

ンストールする必要があります。ドライバ・ソフトウェアをインストー

ルした後に、E5813Aを LAN に接続して、PC が E5813A に接続

できるようになります。また、E5813A の 5 つの USB ポートが

Windows® の追加 USB ポートとして認識されます。これらのポート

は、USB 機器、汎用デバイス、E5805A USB- RS232 コンバータ、

82357A USB- GPIB コンバータに接続するために使用できます。

Agilent IO Libraries Suite が収録されたオートメーションレディ

CD を使用すると、I/O ライブラリ (VISA、VISA COM、SICL など

) を使用して機器、デバイス、コンバータのプログラムを作成できます。

この CD には接続管理やインタラクティブな機器制御のためのツール

セットも含まれています。VISA やその他の T&M 専用ソフトウェアを

使用してプログラムを作成する場合、機器制御を行うアプリケーション

ソフトウェアを使用する場合に、IO Libraries Suite をインストール

することもできます。

注
82357A を使用する場合、正しい 82357A ドライバがアクセスされるために

は、E5813A に IO Libraries Suite バージョン 14.0 以上がインストールされ

ている必要があります。
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ドライバのアンインストール

E5813A LAN- 5ポートUSBハブのドライバをアンインストールするに

は、以下の手順を実行します。

1 [スタート ] メニューから E5813A 設定ユーティリティを起動します。

2 [File (ファイル )] メニューから [Preferences (基本設定 )] を選択

し、[Uninstall (アンインストール )] ボタンをクリックします。 ドラ

イバの削除を完了するには、PC を再起動する必要があります。



LAN-5ポートUSBハブ 1

E5813A LAN-5ポートUSBハブ 37

ステータス ランプの説明

E5813A LAN- 5 ポートUSB ハブには、フロント パネル上に 6 つの

LED (システム ステータス LED、5 つのハブ LED) があります。各

LED は、赤、緑、オレンジの 3 色に点灯します。

システム ステータス ランプ

電源を最初に入れると、システムが初期化されている間、システム ステー

タス LED が 2 秒間オレンジ色に点灯し、次に緑色の点滅に変わります。

ハブ ランプ

緑色が端から端を行き来するように点灯 ホストに接続されていません。

ポート 1-3-5 と 2-4 が交互にオレンジ色に点灯 フラッシュ内のイメージを更新中です。フラッシュの更新中は集線

装置の電源をオフにしないでください。電源をオフにすると、集線

装置が破損します。

緑色に点灯 ハブ ポートの電源がオンになっています。

赤色の上を緑色が端から端を行き来するように点灯 最寄りのカスタマ センタにご連絡ください。カスタマ センタの連

絡先は、http://www.agilent.co.jp/find/assist でご確認ください。
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設定ユーティリティ・プログラムの使用

E5813A 設定ユーティリティでは、サブネットごとにグループ化された

E5813A LAN- 5ポートUSBハブが表示されます。ユーティリティによっ

て、ローカル サブネット上のデバイスが自動的に検出されます。別のネッ

トワーク上のデバイスを検出するには、そのネットワーク アドレスを検出

リストに追加します。[Edit (編集 )] メニューから [Discovery List (
検出リスト )] を選択します。サブネットのアドレスを検出リスト マネー

ジャに追加します。たとえば、クラス C のネットワーク 10.21.1 を追加

するには、「10.21.1.255」と入力します。サブネット ブロードキャストを

通過させるようにルータを設定する必要があることに注意してください。
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基本設定メニュー オプション

[File (ファイル )] メニュー - [Preferences (基本設定 )]
検出された集線装置のリストをユーティリティが更新する頻度を変更した

り、更新を無効にしたりできます。また、システム イベント ログにドライ

バ イベントを記録できるようにしたり、ドライバをアンインストールした

りできます。

[Edit (編集 )] メニュー - [Connection List (接続リスト )]
ホスト PC の接続先となる E5813A LAN- 5ポートUSBハブの IP ア
ドレスが表示されます。接続リストに IP アドレスを追加すると、ホスト

PC はすぐにデバイスへの接続を試行します。接続リストから IP アドレス

を削除すると、集線装置に接続されているすべての USB デバイスがホス

ト PC から削除されます。

[Edit (編集 )] メニュー - [Discovery List (検出リスト )]
設定ユーティリティが E5813A LAN- 5ポートUSBハブを検索するリ

モート ネットワークのサブネット アドレスが表示されます。

[Command (コマンド )] メニュー - [Configure (設定 )]
デバイスの TCP/IP パラメータを設定します。[Connect to this
Concentrator (この集線装置に接続する )] チェック ボックスをオンに

して、IP アドレスを E5813A LAN- 5ポートUSBハブの接続リストに

追加することができます。

[Command (コマンド )] メニュー - [Connect (接続 )]
E5813A LAN- 5ポートUSBハブの IP アドレスを接続リストに追加し

ます。

[Command (コマンド )] メニュー - [Event Log (イベント ログ )]
E5813A LAN- 5ポートUSBハブからイベント情報を取得します。技術サ

ポートに必要な情報は、このオプションを使用して収集します。

[Command (コマンド )] メニュー - [Reboot (再起動 )]
集線装置を再起動します。

[View (表示 )] メニュー - [Driver Information (ドライバ情報 )]
E5813A LAN- 5ポートUSBハブのドライバのバージョン番号を表示しま

す。また、ドライバをアンインストールできます。

[View (表示 )] メニュー - [Refresh (更新 )] (F5)
検出された E5813A LAN- 5ポートUSBハブのリストを更新します。
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E5813A と USB ハブについて

プラグアンドプレイ アーキテクチャの重要なコンポーネントであるハブ

は、単一接続ポイントをマルチ接続ポイントに変換し、複数のデバイスの接

続を可能にする集線装置です。

E5813A は、LAN を USB に変換するコンバータです。LAN トラ

フィックには遅延があるため、E5813A に USB を RS232 に変換

するデバイスを接続する場合にはハードウェア　フロー　制御

(RTS/CTS または DTR/DSR) を使用する必要があります。

またUSB アーキテクチャでは、( このセクションで後に説明する )
一定の電力制限を伴ったカスケード型のマルチ ハブ構成が可能です。図 1
を参照してください。

図 1

各ハブには、ホストに接続するアップストリーム ポート、ダウンストリー

ム デバイス (別のハブを含む) に接続する複数のダウンストリーム ポート

があります。ハブはダウンストリーム デバイスの接続および取り外しを検

出し、基本ハードウェアおよびオペレーティング システム経由でのダウン

ストリーム デバイスへの電力供給を有効にして、それを監視します。

各 USB デバイスは必要とする電力をオペレーティング システムに報告

し、オペレーティング システムは必要な電力と使用可能な電力量に応じて、

デバイスを有効化または無効化します。高電力デバイスは通常、セルフ・パ

ワード・ハブに接続する必要があります。この種類のハブは、外部電源アダ

プタから電力を受け、各ダウンストリーム ポートに最大 500 mA の電力
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を供給します。バス・パワード・ハブに接続できるのは、マウスなどの簡易

デバイスのみです。この種類のハブは、アップストリーム ホストから電力

を受け、各ダウンストリーム ポートに最大 100 mA の電力を供給します。

バス・パワード・ハブで使用できる電力は限られているため、2 つのバス・

パワード・ハブのカスケード接続は無効で、2 番目のハブに接続されたデバ

イスは機能しません。(USB の仕様では、バス・パワード・ハブの接続先を

セルフ・パワード・ハブまたはホストのみに制限しています。) 

USB の仕様によると、カスケード接続では、最大 5 台のハブを連続して

接続することができます。つまり、デバイスとホストとの間に最大 5 台の

ハブを接続できます。これは、システムにおけるハブの最大数が 5 台であ

るという意味ではありません。実際には、どのレベルにおいても最大 7 台
のハブを並列で接続できます。ダウンストリーム ハブの数は、外部ハブと

内蔵ハブの両方を含めて計算する必要があります。

注
E5813A はセルフ・パワード USB ハブを装備しており、簡易 USB デバイス

または高速 USB デバイスへの電力供給に使用できます。
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サポート

サポートが必要な場合は、カスタマ センタにご連絡ください。最寄りのカ

スタマ センタの連絡先は、http://www.agilent.co.jp/find/assist で
ご確認ください。
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この付録には、E5813A Agilent LAN-5ポートUSBハブの技術仕様および補足情報が

記載されています。



付録 A 45

E5813A の仕様

技術仕様

技術仕様

一般要件

最小システム要件 Windows 2000/XP。USB ポート

規格 USB 1.1、2.0 互換。USB 2.0 デバイスは 12 Mbps で動作

一般特性

電源 出荷時の仕様は 120/230 Vac 60/50 Hz (5 Vdc、最大 3 A)

コネクタ RJ45 Ethernet ～ USB ポート (x 5)

設定 リモート設定ユーティリティ

アップグレード ソフトウェアとファームウェアをフィールドアップグレード可能

IP アドレスの割り当て DHCP サーバからの IP アドレスと固定 IP アドレスの両方をサポート

ネットワークのサポート 10/100 BaseT をサポート

デバイスのステータス LED でシステムおよびデバイスのステータスを表示

データ レート 1 USB ポートあたり最大 12 Mbps

IP アドレス 装置 1 台に 1 つの IP アドレス

ダウンストリーム デバイス 1 台につき 500 mA のダウンストリーム電力

サーバのサポート シングル プロセッサとマルチ プロセッサをサポート

装置 /サーバ 1 サーバにつき最大 8 台の装置をサポート

OHCI 2 台の OHCI (Open Host Controller Interface) コントローラ

イベント ログ Windows システム イベント ログを使用して、問題を簡単に解決可能

推奨するネットワークとデバイス

ネットワーク使用率 50% 未満

互換性 バルク転送またはインターラプト転送の USB デバイスに対応。

アイソクロナス転送は非対応

寸法

長さ x 幅 x 高さ 11.05 cm x 18.29 cm x 2.61 cm

質量 283.49 グラム
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技術仕様

環境仕様

動作環境 0 ℃ ～ 60 ℃

湿度 0 ℃ ～ 95 ℃ (非結露 )


